12 Projets @

Powerpoint 2016

Projet 1:7 Taches

Les Taches

Les Réponses

1. Créez une nouvelle disposition de diapositive nommée
"Personnaliséel" avec un espace réservé pour l'image
a gauche et un espace réservé au texte a droite.
Conservez tous les espaces réservés par défaut.
La taille et la position des nouveaux espaces réservés
sont sans importance.

"~ Suivez les étapes suivantes :

» Affichage

» Masque des diapositives (se trouve dans le groupe
Modes Masque)

> Insérer une disposition (se trouve dans le groupe
Modifier la forme de base)

> Insérer un espace réservé (se trouve dans le groupe
Mise en page du masque)

> Sélectionnez Image et tracez la zone réservée a
I'image a gauche puis texte et tracez la zone
réservée au texte a droite.

» Renommer (se trouve dans le groupe Modifier la
forme de base)

> Saisissez le nom "Personnaliséel" puis cliquez sur
renommer

» Désactivez le mode Masque

2. Disposez les images de la diapositive 2 de maniere a
les aligner sur leur centre.

&7 Sélectionnez les images de la diapositive 2 et suivez les
étapes suivantes :
> Accueil

> Organiser (se trouve dans le groupe Dessin)

> Répéter les lignes d’en-téte (se trouve dans le
groupe Données)

> Aligner

> Aligner au milieu

3. Réorganisez I'animation des images de la diapositive 2
de maniére a les faire apparaitre en fondu une par une
de gauche a droite.

57 Sélectionnez la diapositive 2 et suivez les étapes
suivantes :
> Animations

> Volet Animation (se trouve dans le groupe
Animation avancée)

» Réorganisez I'animation des images selon I'ordre
1234

4. Dans la diapositive 3, modifiez la couleur de I'icone de
la voiture sur Bleu et ajoutez un contour Jaune.

" Sélectionnez I'icdne de la voiture dans la diapositive 3
et suivez les étapes suivantes :
> Outils de dessin/Format

> Remplissage (se trouve dans le groupe Styles de
formes)
> Choisissez la couleur Bleu




» Contour (se trouve dans le groupe Styles de
formes)
» Choisissez le contour Jaune

5. Dans la diapositive 3, animez l'icone de la voiture afin
qu'elle entre par la droite.

&~ Sélectionnez I'icdne de la voiture dans la diapositive 3 et
suivez les étapes suivantes :
> Animations

» Sélectionnez Entrée brusque dans le groupe
Animations

» Changez Options d’effet en utilisant A partir de
la droite

6 Enregistrez la présentation dans le dossier Documents
sous forme d'un fichier PDF intitulé "Présentation".

57 Suivez les étapes suivantes :
> Fichier
> Enregistrer sous
> Sélectionnez Documents puis saisissez le nom
"Présentation"
> Sélectionnez le type PDF puis cliquez sur
Enregistrer

7 Configurez I'impression pour imprimer uniquement la
section " Introduction".

57 Suivez les étapes suivantes :
» Fichier

> Imprimer
» Cochez la section " Introduction" dans paramétres

Projet 2 : 5 Taches

Les Taches

Les Réponses

1. Modifiez la taille des diapositives en les paramétrant
a 20,32 cm de large et 27,94 cm de haut.

Faites une mise a I'échelle du contenu pour I'adapter.

 Suivez les étapes suivantes :
> Création

> Taille des diapositives (se trouve dans le groupe
Personnaliser)

> Taille de diapositive personnalisée

» Modifiez la largeur et la hauteur puis cliquez sur OK

2. Créez un diaporama personnalisé nommé
"Evaluation" et comportant uniquement les
diapositives 1, 2,3,4,5,7,8 et 9.

57 Suivez les étapes suivantes :
> Diaporama

Diaporamas personnalisés
Nouveau

Y V V

Saisissez le nom "Evaluation" et sélectionnez les
diapositives 1, 2, 3, 4, 5, 7, 8 et 9 puis cliquez sur
Ajouter, OK, et Fermer

3. Incorporez les polices seulement pour les caractéres
utilisés dans la présentation. Enregistrez la
présentation.

57 Suivez les étapes suivantes :
»  Fichier
> Options
> Enregistrement
» Cochez Incorporer les polices dans le fichier




» Cochez Incorporez uniquement les caracteéres
utilisés dans la présentation
» Cliguez sur OK puis sur Enregistrer

4. Dans la diapositive 7, appliquez a I'image le style Coin
diagonal arrondi, blanc et I'effet Emballage plastique.

57 Sélectionnez I'image dans la diapositive 7 et suivez les
étapes

suivantes :

> Outils Image
Format
Sélectionnez le style Coin diagonal arrondi, blanc
Sélectionnez dans Effets Artistiques I'effet
Emballage plastique

Y V V

5. Dans la diapositive 9, configurez le clip audio en
lecture automatique. Masquez l'icone pendant la
présentation.

¥~ Sélectionnez le clip audio dans la diapositive 9 et suivez
les étapes suivantes :
> Outils Audio
» Lecture
» Choisissez Automatiquement dans le groupe
Options audio puis cochez Masquez pendant la

présentation

Projet 3 : 5 Taches

Les Taches

Les Réponses

1. Aprés la diapositive '"Les intervenants",
importez de nouvelles diapositives a partir du
plan du document Word En ordre.docx situé
dans le dossier objets ppt .

&~ Cliquez aprés la diapositive "Les intervenants"
et suivez les étapes suivantes :
> Accueil
» Nouvelle diapositive (se trouve dans le groupe
Diapositives)
>

>

Diapositives a partir d’un plan
Sélectionnez le document Word En ordre.docx puis
cliquez sur Insertion

2. Appliquez la disposition Surligner a la
diapositive intitulée "Les intervenants".

57 Sélectionnez la diapositive intitulée

"Les intervenants" et suivez les étapes suivantes :
Methodel :

> Accueil

» Disposition (se trouve dans le groupe Diapositives)

> Sélectionnez Surligner
Methode2 :

> Clic droit sur la diapositive intitulée

"Les intervenants"
> Disposition
» Surligner

3. Dans la diapositive "Les intervenants",
appliquez I'effet Biseau en Angle aux six
photographies.

&~ Sélectionnez les six photographies de la diapositive
intitulée "Les intervenants" et suivez les étapes
suivantes :
> Outils Images

» Effets de I'image (se trouve dans le groupe Styles
d’image)
» Choisissez I'effet Biseau en Angle




4. Dans la diapositive "programme de la journée
", modifiez la mise en forme de la liste pour en
faire une liste a deux colonnes.

¥ Sélectionnez la liste dans la diapositive intitulée
"programme de la journée "et suivez les étapes
suivantes :
>  Accueil

> Ajouter ou supprimer des colonnes (se trouve dans
le groupe Paragraphe)
» Sélectionnez deux colonnes

5. Ajoutez une transition en Fondu entre toutes
les diapositives.

57 Suivez les étapes suivantes :
> Transition

> Sélectionnez Fondu dans le groupe Transition vers
cette diapositive

> Cliquez sur Appliquer partout dans le groupe
Minutage

Projet 4 : 4 Taches

Les Taches

Les Réponses

1. A la fin de la présentation, ajoutez de nouvelles
diapositives a partir du plan du document Word
reste.docx dans le dossier Objets_ppt.

57 Cliquez sur la fin de la présentation et suivez les étapes
suivantes :
» Accueil

> Nouvelle diapositive (se trouve dans le groupe
Diapositives)

> Diapositives a partir d’un plan

> Sélectionnez le document Word reste.docx puis
cliquez sur Insertion

Modifiez le graphique de la diapositive 7 pour en faire
un graphique en Aires 3D.

57 Sélectionnez le graphique de la diapositive 7 et suivez

les étapes suivantes :

» Outils de graphique

> Création

» Modifiez le type de graphique (se trouve dans le
groupe Type)

> Cliquez sur le type Aires, sélectionnez 3D puis
cliquez sur OK

Masquez les commentaires de la présentation.

57 Suivez les étapes suivantes :
> Révision
> Afficher les commentaires (se trouve dans le
groupe Commentaires)
> Décochez Afficher les marques

Appliquez le style Style moyen 2 - Accentuation 3 au
tableau de la diapositive 6. Modifiez le style de
maniére a avoir une couleur de remplissage en
alternance pour les colonnes mais pas pour les lignes.

&~ Sélectionnez le tableau de la diapositive 6 et suivez
les étapes suivantes :
> Outils de tableau

» Création

> Sélectionnez Style moyen 2 - Accentuation 3 dans
le groupe Styles de tableau

» Décochez Lignes a bandes et cochez Colonnes a
bandes dans le groupe Options de style de tableau




Projet 5 : 5 Taches

Les Taches

Les Réponses

1. Alafin de la présentation, ajoutez de nouvelles
diapositives a partir du plan du document
Word derniere partie.docx dans le dossier objets_ppt..

%~ Cliquez a la fin de la présentation et suivez les étapes
suivantes :
> Accueil

» Nouvelle diapositive (se trouve dans le groupe
Diapositives)

> Diapositives a partir d’un plan

» Sélectionnez le document Word derniére
partie.docx puis cliquez sur Insertion

2. Modifiez le Masque du document pour que le pied de
page gauche contienne le texte "Brouillon".

57 Suivez les étapes suivantes :
> Affichage

» Masque du document (se trouve dans le groupe
Modes Masque)

» Remplacez le pied de page gauche par le texte
"Brouillon"

> Fermezle mode Maque

3. Dans la diapositive 8, appliquez le style Effet modéré -
Rouge foncé, 1 accentué a la forme Nuage.

57 Sélectionnez la forme Nuage dans la diapositive 8 et
suivez les étapes suivantes :
» Outils de dessin

> Format
» Sélectionnez appliquez le style Effet modéré -
Rouge foncé, 1 accentué

4. Dans la diapositive 9, supprimez du tableau la colonne
ayant I'en-téte "Tarifs". Ajoutez deux lignes vides entre
"Suite Deluxe" et "Suite Junior".

57 Sélectionnez la diapositive 9 et suivez les étapes
suivantes :
Pour supprimer la colonne :

Sélectionnez la colonne ayant I'en-téte "Tarifs"
Outils de tableau
Disposition

YV V V V

Supprimer (se trouve dans le groupe Lignes et
colonnes)

A\

Supprimer les colonnes

Pour ajouter les lignes :

Cliquez sur la ligne "Suite Deluxe"
Outils de tableau

Disposition

YV V VYV V

Cliquez deux fois sur Insérer dessous (se trouve
dans le groupe Lignes et colonnes)

5. Réglez la durée de toutes les transitions entre les
diapositives sur exactement 3 secondes et le son sur
[Aucun son].

 Suivez les étapes suivantes :
» Transition

» Réglez dans le groupe Minutage la durée sur 3
secondes, sélectionnez [Aucun son] dans la zone
son puis cliquez sur Appliquer partout




Projet 6 : 5 Taches

Les Taches

Les Réponses

1. Dans la diapositive 4, rognez la vidéo en sorte que la
zone visible commence a 3,81 cm de la marge gauche.

5~ Sélectionnez la vidéo dans la diapositive 4 et suivez
Les étapes suivantes :
> Cliquez sur le bouton droit et sélectionnez Format
vidéo
> Cliguez sur Rogner et saisissez 3,81 cm dans la
zone Décalage X puis tapez Entrée

2. Dans la diapositive 5, appliquez le mouvement Cercle a
la forme Etoile & 24 branches.

&~ Sélectionnez la forme Etoile dans la diapositive 5 et
suivez les étapes suivantes :
»  Animation

» Autres mouvements (se trouve dans le groupe
Animation)
» Sélectionnez Cercle puis cliquez sur OK

3. Ajoutez un espace réservé pour un élément multimédia
a la disposition "Support en plein écran". Positionnez-le
sous l'espace réservé au titre. Alignez les marges
gauche et droite sur les marges de |'espace réservé au
titre.

57 Suivez les étapes suivantes :
> Affichage

» Masque des diapositives (se trouve dans le groupe
Modes Masque)

> Sélectionnez la disposition "Support en plein
écran”

» Cliguez dans le groupe Mise en page du masque
sur Insérer un espace réservé et sélectionnez
Support puis insérez le sous le titre

> Alignez les marges gauche et droite en les ajustant
avec les marges de |'espace réservé au titre

4. Dupliquez la diapositive 12.

57 Sélectionnez la diapositive 12 et suivez les étapes
suivantes :
» Cliquez sur le bouton droit

> Dupliquez la diapositive

5. Dans la diapositive 7, convertissez la liste des confitures
en un graphique SmartArt Liste verticale avec images.

&7 Sélectionnez la liste des confitures dans la diapositive
7 et suivez les étapes suivantes :
Methodel :
> Outils de dessin/Format
» Convertir en graphique SmartArt (se trouve dans
le groupe Paragraphe)
> Sélectionnez le type intitulé Liste verticale avec
images




Projet 7 : 5 Taches

Les Taches

Les Réponses

. Supprimez la diapositive 8, dont le titre est "Croissance

par région".

&~ Sélectionnez la diapositive 8 et suivez les étapes
suivantes :
> Cliguez sur le bouton droit

> Supprimer la diapositive

. Configurez les options d'impression pour imprimer cing
exemplaires de la présentation avec trois diapositives
par page. Tous les exemplaires de la premiére page doit

étre imprimés avant ceux de la deuxieme page.

5~ Suivez les étapes suivantes :
> Fichier

Imprimer
Saisissez 5 dans la zone Copies

YV V VY

Cliquez sur Diapositives en mode Pages et
sélectionnez 3 diapositives

A\

Cliquez sur Assemblées et sélectionnez non
assemblées

. Dans la diapositive 3, alignez le texte "C’est une source
de bienfaits et de vitamines." sur le haut de la zone de

texte et appliquez |'effet Petites majuscules.

¥~ Sélectionnez dans la diapositive 3 le texte "C’est
une source de bienfaits et de vitamines." et suivez les
étapes suivantes :
Pour aligner le texte sur le haut :
» Accueil
> Aligner le texte (se trouve dans le groupe
Paragraphe)
» Sélectionnez Haut
Pour appliquer I'effet Petites majuscules :
» Cliquez sur le lanceur Police
» Cochez Petites majuscules et cliquez sur OK

. Dans la diapositive 3, groupez toutes les images.

¥~ Sélectionnez toutes les images de la diapositive 3 et
suivez les étapes suivantes :
» Cliquez sur le bouton droit

> Grouper/ Grouper

. Modifiez le style du graphique de la diapositive 7 en lui

attribuant le Style 15, et modifiez les couleurs en
sélectionnant la palette Couleur 7 (Palette
monochrome 7) dans la section Monochrome.

57 Sélectionnez le graphique de la diapositive 7 et suivez
les étapes suivantes :
» Outils de graphique

» Création

» Sélectionnez le Style 15

» Cliquez sur Modifier les couleurs et sélectionnez
Palette monochrome 7




Projet 8 : 4 Taches

Les Taches

Les Réponses

1. Changez le theme du masque en appliquant le Theme
Office et choisissez la police Arial.

5~ Suivez les étapes suivantes :
> Affichage

» Masque des diapositives (se trouve dans le groupe
Modes Masque)

» Cliguez sur la premiére diapositive puis sur
Conserver (se trouve dans le groupe Modifier la
forme de base)

> Dans le groupe Modifier le theme, Choisissez le
Théme Office et la Police Arial

» Fermer le mode Masque

2. Ajoutez une section intitulée "Titre" avant la
diapositive 1.

¥~ Cliquez avant la diapositive 1 et suivez les étapes
suivantes :
» Accueil

» Section (se trouve dans le groupe Diapositives)
> Ajouter une section
> Saisissez le nom "Titre" puis cliquez sur Renommer

3. Modifiez le style du tableau de la diapositive 3 en
choisissant Style moyen 1 - Accentuation 5

57 Sélectionnez le tableau de la diapositive 3 et suivez les
étapes suivantes :
> Options de tableau

> Création
» Sélectionnez dans Styles de tableau Style moyen 1
- Accentuation 5

4. Amenez le texte de la diapositive 4 devant I'image du
pont. Envoyez ensuite I'image des Tentes a l'arriére-
plan.

" Sélectionnez le texte de la diapositive 4 et suivez
les étapes suivantes :
Methodel :
> Format
> Avancer (se trouve dans le groupe Organiser)
> Avancer
Methode?2 :
> Accueil
> Organiser (se trouve dans le groupe Dessin)
> Avancer

¥~ Sélectionnez ensuite I'image des Tentes de
la diapositive 4 et suivez les étapes suivantes :
Methodel :
» Format
» Reculer (se trouve dans le groupe Organiser)
» Mettre a l'arriere-plan




Methode?2 :

» Accueil

> Organiser (se trouve dans le groupe Dessin)
> Mettre a l'arriere-plan

Projet 9 : 5 Taches

Les Taches Les Reponses
¥~ Sélectionnez la diapositive 5 et suivez les étapes
1. Dans la diapositive 5 uniquement, ajoutez un pied de suivantes :
page contenant le texte "Le modéle relationnel". > Insertion

» En-téte/pied (se trouve dans le groupe Texte)
> Saisissez le texte "Le modéle relationnel" dans la
zone Pied de page puis cliquez sur Appliquer

5~ Suivez les étapes suivantes :
» Diaporama

> Diaporama personnalisé (se trouve dans le groupe

Démarrage du diaporama)
2. Utilisez les diapositives 5 a 7 pour créer un diaporama >

- s X " Nouveau
personnalisé nommé "Graphiques".

> Sélectionnez les diapositives 5,6 et 7

> Cliquez sur Ajouter et saisissez le nom
"Graphiques" dans la zone Nom du diaporama
puis cliquez sur OK

&~ Sélectionnez le tableau de la diapositive 7 et suivez les
étapes suivantes :
> Insertion
> Graphique (se trouve dans le groupe Illustrations)
» Sélectionnez Courbes et choisissez le type Courbes
puis cliquez sur OK

» Redimensionnez le graphique, sélectionnez les

3. Créez un graphique en Courbes dans la diapositive 7 a données du tableau de la diapositive 7 et collez les
partir des chiffres du tableau de la méme diapositive.

Utilisez les années pour les Catégories et "Nouveaux
clients" pour la série. Le redimensionnement du
graphique est facultatif.

dans la feuille de calcul Excel

&~ Sélectionnez ensuite le graphique et suivez les étapes

suivantes :

> Outils de graphique

> Création

» Sélectionner des données (se trouve dans le
groupe Données)

» Cliquez sur Changer de ligne ou de colonne puis
modifiez le nom de la série en saisissant
"Nouveaux clients" et cliquez sur OK

¥~ Sélectionnez la diapositive 4 et suivez les étapes
4. Dans la diapositive 4, insérez la vidéo Le modéle suivantes :

relationnel.avi, située dans le dossier Objets_ppt. > Insertion
Positionnez la vidéo a 5,08 cm du Coin supérieur

Vidéo (se trouve dans le groupe Média)
gauche, verticalement et horizontalement.

Vidéo sur mon PC

Y V VYV

Sélectionnez la vidéo et Cliquez sur Insérer

Pour positionner la vidéo a 5,08 cm, suivez les étapes
suivantes :




> Lecture
» Cliquez sur le lanceur Taille

\4

Saisissez 5.08 cm dans la zone Position horizontale
et la zone Position verticale

5. Modifiez la durée de toutes les transitions a 2 secondes.

57 Suivez les étapes suivantes :
» Transition

» Dans le groupe Minutage, modifiez la durée a
2 secondes
» Cliquez sur Appliquer partout

Projet 10 : 5 Taches

Les Taches

Les Réponses

1. Dans la diapositive 2, regroupez I'image de réussite et
son titre.

&~ Sélectionner dans la diapositive 2 I'image de réussite et
son titre et suivez les étapes suivantes :
> Cliquez sur le bouton droit

» Sélectionner Grouper/Grouper

2. Dans la diapositive 3, supprimez la ligne "Usines" du
tableau, puis insérez une nouvelle colonne intitulée
"Planifications totales" a droite.

&~ Sélectionner dans la diapositive 3 |a ligne "Usines" et
suivez les étapes suivantes :
» Outils de tableau

» Disposition

» Supprimer (se trouve dans le groupe Lignes et
colonnes)

> Supprimer les lignes

Pour insérez une nouvelle colonne a droite, suivez les
étapes suivantes :
» Cliquez a droite du tableau

Outils de tableau
Disposition

VYV V VY

Insérer a droite (se trouve dans le groupe Lignes
et colonnes)
> Saisissez le titre "Planifications totales"

3. Dans la diapositive 4, modifiez le graphique de
maniére a ce que la liste des étiquettes de catégorie

apparaisse dans la partie centrale supérieure du
graphique. Les étiquettes doivent chevaucher le
graphique.

Sélectionner dans la diapositive 4 la liste des

étiquettes de catégorie et suivez les étapes

suivantes :

» Outils de graphique

> Format

» Mise en forme de la sélection (se trouve dans le
groupe Sélection active)

» Cochez Haut et décochez Afficher la Iégende sans
recouvrir le graphique

4. Dans la diapositive 5, ajoutez une Liste pyramidale
contenant de haut en bas les mots "Plan", "Poste" et
"Bureau". Appliquez le style Encastré.

Le redimensionnement de la pyramide est facultatif.

&7 Sélectionnez la diapositive 5 et suivez les étapes
suivantes :
» Insérer

» SmartArt (se trouve dans le groupe Illustrations)
> Cliquez sur Pyramidale sélectionnez Liste
pyramidale

10



» Redimensionnez le graphique et saisissez les mots
"Plan", "Poste" et "Bureau" dans les zones de texte

Appliquez le style Encastré en suivant les étapes suivantes :
» Outils SmartArt

5. Configurez les options d'impression pour imprimer
les Pages de notes de toutes les diapositives.

» Création
» Sélectionnez le style Encastré dans le groupe
Styles SmartArt
" Suivez les étapes suivantes :
> Fichier
» Imprimer
» Cliquez sur Diapositives en mode Page
> Sélectionnez Pages de notes

Projet 11 : 5 Taches

Les Taches

Les Réponses

1. Configurez la vidéo de la diapositive 2 pour débuter a
"00:00,500" et se terminer a "00:02,500".

&~ Sélectionnez la vidéo de la diapositive 2 et suivez les
étapes suivantes :
> Outils vidéo

> Lecture

» Découper la vidéo (se trouvent dans le groupe
Edition)

> Saisissez "00:00,500" dans la zone Heure de debut
et "00:02,500" dans la zone Heure de fin puis
validez par OK

2. Animez le texte de la diapositive 3 de maniére a ce que
chaque puce effectue individuellement un effet de
balayage de gauche a droite suite a un clic.

¥~ Sélectionnez le texte de la diapositive 3 et suivez les
étapes suivantes :
» Animation

» Sélectionnez Balayer dans le groupe Animation

> Sélectionnez I'effet A partir de la gauche et I'effet
Par paragraphe dans Options de |'effet

» Sélectionnez Au clic dans la zone Démarrage

3. Dans la diapositive 3, remplacez le cercle par un cceur.

&~ Sélectionnez la zone de texte dans la diapositive 3 et

suivez les étapes suivantes :
» Outils de dessin

> Format

» Modifiez la forme (se trouve dans le groupe
Insérer des formes)

» Sélectionnez le coeur

4. Recherchez et supprimez les annotations et le contenu
positionnés hors de la diapositive.

57 Suivez les étapes suivantes :
> Fichier

Vérifier I'absence de problémes

Inspecter le document

Cochez Contenu des objets hors diapositive
Inspecter

YV VYV V VY

Supprimer tout le contenu des objets hors
diapositive puis cliquez sur Fermer

11



5. Ajoutez une nouvelle diapositive a la fin de la
présentation, en utilisant le fichier Science
fiction.docx situé dans le dossier Objets_ppt.

¥~ Cliquez a la fin de la présentation et suivez les étapes

suivantes :
> Accueil

> Nouvelle diapositive (se trouve dans le groupe
Diapositives)
Diapositive a partir d’un plan

v

» Sélectionnez le fichier Science fiction.docx et
cliquez sur Insertion

Projet 12 : 4 Taches

Les Taches

Les Réponses

1. Dans la diapositive 2, déplacez le groupe d'objets
"Les fleurs aromatiques" a l'arriere-plan.

& Sélectionnez dans la diapositive 2 le groupe
d'objets "Les fleurs aromatiques" et suivez les
étapes suivantes :

Methodel :
» Format

» Reculer (se trouve dans le groupe Organiser)
> Arriere-plan

Methode?2 :

» Accueil

> Organiser (se trouve dans le groupe Dessin)
> Arriere-plan

2. Réglez I'effet de transition sur "A partir du bas" pour
toutes les diapositives.

5~ Suivez les étapes suivantes :
» Transition

> Options d’effet (se trouve dans le groupe
Transition vers cette diapositive)

> Sélectionnez "A partir du bas" puis cliquez sur
Appliquer partout

3. Dans la diapositive 10, appliquez le style Word Art
Motif de remplissage - Violet foncé, Accentuation 3,
Rayures étroites horizontales, Ombre intérieure
(Motif de remplissage Violet foncé, Couleur
d'accentuation 3, Rayures étroites horizontales;
Ombre intérieure) au texte "CYCLE DE LA PLANTE".

&~ Sélectionnez dans la diapositive 10 le texte "CYCLE DE
LA PLANTE" et suivez les étapes suivantes :
» Outils de dessin

> Format

> Sélectionnez dans le style Word Art le style Motif
de remplissage - Violet foncé, Accentuation 3,
Rayures étroites horizontales, Ombre intérieure

4. Déplacez la diapositive "Réceptacle floral" pour l'insérer
entre les diapositives "Lupin" et "Roses jaunes".

%57 Sélectionnez la diapositive "Réceptacle floral" et

suivez les étapes suivantes :
» Utilisez la commande Couper

» Cliguez entre les diapositives "Lupin" et "Roses
jaunes"

» Utilisez la commande Coller pour insérer la
diapositive
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Projet 13 : 4 Taches

Les Taches

Les Réponses

1. Modifiez la puce de niveau supérieur du Masque des
diapositives en utilisant le fichier vérification.png situé
dans le dossier objets_ppt.

& Suivez les étapes suivantes :

>
>

YV V VYV VY

Affichage

Masque des diapositives (se trouve dans le groupe
Modes Masque)

Sélectionnez la premiéere disposition puis le
niveau supérieur de la liste a puces (La premiére
ligne)

Accueil

Puces (se trouve dans le groupe Paragraphe)
Puces et numéros

Cliquez sur Image

Sélectionnez A partir d’un fichier

Sélectionnez le fichier vérification.png situé dans
le dossier objets_ppt et cliquez sue Insérer

2. Modifiez les propriétés du fichier en saisissant le Titre
"Bilan des accidents de la circulation".

&~ Suivez les étapes suivantes :

>
>

Fichier
Saisissez "Bilan des accidents de |a

circulation"dans la zone Titre

3. Dans la diapositive 3, ajoutez a la phrase "Cliquez ici
pour consulter notre site Web" un lien hypertexte
pointant sur le site "http://www.giac-btp.com".

¥~ Sélectionnez dans la diapositive 3 la phrase "Cliquez
ici pour consulter notre site Web" et suivez les étapes
suivantes :

>

>
>
>

Insérer

Lien (se trouve dans le groupe Liens)

Insérer un lien

Saisissez "http://www.giac-btp.com" dans la zone

Adresse et validez par OK

4. Insérez le commentaire "Mettre a jour" sur le graphique
de la diapositive 2.

&~ Sélectionnez le graphique de la diapositive 2 et suivez
les étapes suivantes :

>
>

>

Révision

Nouveau commentaire (se trouve dans le groupe
Commentaires)

Saisissez le commentaire "Mettre a jour"
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